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PROJECT OVERVIEW 
 
The West Virginia GIS Technical Center (WVGISTC) is working with the West Virginia 
Department of Transportation (DOT) to scan large format highway plan sheets into digital raster 
images. For every highway Project Book, a single Adobe PDF file of all the sheets is created 
along with an index map that is spatially referenced. The WV Division of Highways Plan Scanning 
Project is fulfilled through a series of steps and processes that are described throughout this 
documentation. Records are kept to document time spent on each process and are used to 
calculate estimations of time and cost for future evaluation. Technicians are expected to keep 
correct records of time spent on each process and record their activity in the DOT_Operator 
access table and the DOT Performance Tracker Google Sheet.  
 
SEVEN MAJOR PROCEDURAL TASKS:  
 
The scanning project consists of seven major work tasks which are described in more detail 
below.  

(1) Book Preparation and File Naming:  Once the Tech Center receives a batch of Project 
Books from the DOT, book preparation can begin. This process consists of placing each Project 
Book in the designated location in the Tech Center, keeping them separate from books that have 
been completed or ones that are file-named and still in progress. Every WV DOT Project Book 
scanned by the WVGISTC will have an entry in the WV DOT Scanning (dbo_Scanning) Database. 
This database consists of key transportation fields for identifying the highway book, unique scan 
order and project key identifiers, scan information for tracking project progress and work tasks, 
index map coordinates, and useful online links for the PDF Book, geographic location, 
ProjectWise location, etc. After they are placed in their proper location, the technician will select 
a Project Book and enter description information about the Project Book in the dbo_Scanning 
table.  Each DOT Project Book gets an entry in this table during the first intake of the plan. This 
consists of recording the information on the transmittal sheet (found on top of the map (in the 
folder/rolled map)) and the Project Book cover sheet. Once all information is documented, the 
technician will then create and record a Scan Order Number on the transmittal sheet and move 
the Project Book and transmittal to the location designated for the named documents that are to 
be scanned. During this, the technician also needs to make sure pages are as neat and organized 
as possible to speed up the scanning step. This might include repairing pages or replacing binder 
clips. 

(2) Sheet Scanning: The technician will begin this process by selecting a Project Book from the 
named books area and bringing it to the scanner workstation. The scanner must be set to specific 
settings before the Project Book can be scanned, which ensures that the image is in the proper 
format and is named correctly. Additionally, a new folder at the scanner workstation must be 
created and should be named according to the Scan Order Number on the transmittal sheet.  After 
these are completed, each page of the document is to be wiped off with the cleaning products 
supplied to protect the scanners from dirt and any other potentially damaging debris. If the 
technician finds that the Project Book is especially dirty or is in bad condition, document protectors 
must be used. These are found on the first two shelves of the filling cabinet worktable, which are 
labelled. Once the technician is sure that the document is clean and the file location and scanner 
settings are correct, the document can be scanned.  After the entire Project Book is scanned, the 
file must be moved from the local workstation to the IncompleteBooks folder. The physical Project 
Book should then be noted that it has been scanned and then placed in designated location. It is 
important to be sure that all Scanner components are maintained and kept clean.  
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(3) Image Processing: This action uses tools created in Photoshop to make image adjustments. 
The files will be loaded into Photoshop and, with the use of an autocontrast tool, which is detailed 
below, will be cleaned up, cropped, and rotated, if necessary. After processing, upload the TIFF 
files into the server folder in the IncompleteBooks folder. 

(4) PDF Creation:  After image processing has been completed, the edited TIFFs are to be 
compiled into a PDF document. To do this, the technician uses Adobe Acrobat Pro to reduce file 
size and recognize text (using Optical Character Recognition).  This process is detailed below. 
After this is completed, the PDF is moved to the PDF folder created on the technicians’ local 
workstation. The document must then be checked and corrected for any rotation or other errors. 
Once the PDF is correct, rename the document using the Scanning ID Number and put the 
finished PDF into the server folder in IncompleteBooks. 

(5) Georeference Plan Index Map:  The technician will use ArcGIS Pro, and Google Maps if 
needed, to find and georeference each cover sheet of the Project Book. This sheet is typically 
found on the first page and is contained in the index map, but it can be found in various places 
throughout the Project Book. The page that has the object to be georeferenced must be copied 
from the TIFF folder and then pasted into the GeoTIFF folder. Once it is in the proper location, 
the technician must open the TIFF and ensure the correct projection (Universal Transverse 
Mercator Zone 17N) is applied. After this is complete, the object’s location needs to be found on 
the map. By using spatial information found throughout the Project Book, the technician can find 
the location with Google Maps and ArcGIS Pro. Once found, the image is to be georeferenced 
based off at least four (4) control points set by the technician but must not exceed ten (10) control 
points.  The georeferenced image will then need to be named according to the DOT naming 
conventions.  The GeoTIFF folder is to be moved from the local workstation to the Project Book’s 
file in IncompleteBooks. 

(6) Quality Control & File Renaming: Due to the complexity in the several earlier processes, a 
special emphasis is placed on quality control and assurance to confirm that the technicians are 
providing the best possible product. The technician will check for accuracy and completion of 
Database entry, filename, image processing, PDF, and GeoTIFF. Upon completion, the 
technician will use the file renaming tool to rename the quality assured folder in the 
IncompleteBooks folder. Once renamed, it will be moved to the ProjectBooksFolders folder.   
Technicians cannot Quality Control their own work. 

(7) Publishing to Web Map:  The final process to the WV Division of Highways Plan Scanning 
Project is uploading the TIFFs, PDF, and GeoTIFFs to the website. First, the PublishGeoTIFF.pyt 
script will run python to copy and replace GeoTIFFs into a new folder that will be used to add scan 
rasters to the mosaic. Once moved into a new folder and added to the mosaic, the technician will 
use the DOTFootprints.pyt tool to create footprints of the georeferenced image. Next, the footprint 
extents need to be copied into the dbo_Scanning table. This is done with the 
UpdateFootprintExtents tool in ArcMap and will automatically update X and Y Min/Max fields in 
the dbo_scanning table. After this tool is finished, the technician must update the 
PublicationStatusID column in dbo_Scanning, which will publish the projectbook to the images in 
the ArcGIS Online Map. Once published, the technician checks the website to ensure it works. 
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VOCABULARY PRIMER 
 

- Project Book: One individual project or plan. This term is interchangeable with ‘plan’, 
‘project’, or ‘book’. These are separated by their transmittal sheets within a folder of 
projects. Can be from one page to hundreds of pages. 

- Project Book Folder: The large manila folders of individual Project Books. Folders can 
have anywhere from one Project Book to many. They need to be kept together and in 
order of their Scan Order Number. When we return plans to the DOT they are kept in this 
folder. 

- Transmittal Sheet: The physical copy of the Project Book information, usually partially 
filled by the DOT when they are sent to us. Every Project Book gets one. The information 
on the sheet includes things such as the title of the project and route information which is 
entered into the DOT Access Database. 

- Scan Order Number: This is the ID assigned to every individual Project Book and is found 
on the transmittal sheet. We assign this number based on the order we enter them into 
the DOT Access database during the naming process. 

- Artifact: Byproduct produced when there is dirt or other unwanted material on the scanner 
lens when scanning a page. Usually forms in a streak like line in the direction the page is 
scanned. 

- TIFF: The file type the pages of a Project Book are digitally stored as. Stands for Tag 
Image File Format and is a handy way to store high quality images for editing. 

- Georeferencing: The process of scaling a plan’s map to its real-world location in ArcGIS 
Pro. 

- GeoTIFF: The georeferenced index page of a plan. Not all project plans will have the 
geoinformation to have a GeoTIFF. Usually uses the cover page of a Project Book’s map. 

- OCR: Optical character recognition. Part of the process of building the individual TIFF files 
into a single PDF book when we run text recognition on the pages to turn the text printed 
on the plan into a digitally recognized version for document searching.  
 

FILE PATHS AND PINNING TO YOUR FILE VIEWER’S QUICK ACCESS 
 
- IncompleteBooks: (\\gistc-filesrv1\DOTScanning\Scanning\IncompleteBooks) 
 - This is the network drive where all in progress Project Books go. 
- ProjectBookFolders: (\\gistc-filesrv1\DOTScanning\Scanning\ProjectBookFolders) 
 - This is the network drive where all complete Project Books go. 
- wvDOT: (R:\DOT\wvDOT_planROW_scanning) 
 - This folder holds the data and management documents for the scanning project. 
 - DOT_Operator.accde is for logging your activity. 
 - DOT.accdb is the overall database for the project. Do not open or edit anything in this 

Access sheet without permission. 
 - The Documents folder holds the manuals. 
To pin the folders to your quick access bar on your file viewer, right click the folder itself and 
select ‘Pin to Quick Access’. It will now be on the left pane of the file viewer.

file://gistc-filesrv1/DOTScanning/Scanning/IncompleteBooks
file://gistc-filesrv1/DOTScanning/Scanning/ProjectBookFolders
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(1)  PROJECT BOOK PREPARATION 
 
The following section explains the overall acquisition process, breaks down the components to 
the naming system, and outlines the steps taken to enter each plan into the access database. 
 
ACQUISITION AND SCANNING 
 
Project plans to be scanned are delivered to the WV GIS Technical Center by DOT personnel. 
The frequency of delivery varies and is based upon operational backlog.  
 
PROJECT BOOK INTAKE 
1) Receive shipment of Project Book Folder(s) from the WV DOT with their respective 

transmittal sheet(s). 
a) Leave plans in the designated location within the WVGISTC for unnamed plans. 

2) Physically move a folder of Project Books to a scanning workstation.  
a) Enter transmittal sheet information into the dbo_Scanning database. Refer to the section 

on naming for details. 
3) Ensure the plan is organized and well bound.  

a) Remove debris, replace damaged clips, and bind unbound plans to keep them together. 
b) This is to minimize repairs, transportation, and organization further on. 

4) Physically move the Project Book(s) to the location with other named books that are 
ready for scanning. 
a) Keep Project Books together with the plans they came with, in their folder of origin. 
 

NAMING PROJECT BOOKS 
Check to see if you have access to Microsoft Access database. If an error window pops up saying 
you cannot use the application, then go to this location "T:\SysAdm\Software\ESRI\SQL Server 
Client-Side Tool Kit.msi" and run the toolkit. After it is finished running, you should have access. 

Every WV DOT Project Book scanned by the WVGISTC will have an entry in the WV DOT Project 
Database named dbo_Scanning.  Before a book can be scanned its information needs to be 
entered into the DOT Access database. This database provides a means for tracking work 
completed along with published information for the Highway Plans Locator web application 
(www.mapwv.gov/dotplans).   

The information needed to fill out the field column of the database can be found on the Project 
Book’s transmittal sheet and/or the cover page. Copy the key transportation fields for finding the 
highway book to the dbo_Scanning table.  Most of the information needed to fill out this table (with 
a few important exceptions described below) can be found on the first page of the Project Book. 

Occasionally pieces of information will be missing from the cover page, such as a title, bridge 
number, or fiscal year.  This information can often be found on other pages within the Project 
Book.  If the information cannot be found anywhere within the Project Book, it should be noted in 
the comments field of the dbo_Scanning table.  

Not all Project Books will have a transmittal sheet, and not all cover pages have all pertinent 
information, so the database should be filled out as much as is possible, but there will be times 
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when information is missing, and columns will remain blank. Contact Hussein Elkhansa of WV 
DOT for aid with missing transmittal information. 

SCANNING FILE NAME CONVENTION 
 
The following section explains the file naming convention, a fixed-length alpha-numeric name of 
30 digits that describes the project being named. The first 18 characters follow the WV DOT 
County Route ID naming convention. Folder structures and scanned files will adopt this 
convention for file organization.  All the files will be complete to include leading zeroes and null 
values so that all Project Key Numbers have the same fixed length format.  Fields are separated 
by underscores within the file name for readability.  
 

 

PROJECT KEY NUMBER:  The unique ID number generated for each project book. The first 8 
fields are concatenated and separated with underscores to create this Project Key Number which 
is also the file folder name.  The last two fields are for the sheet names of the individual scanned 
TIFF files; total file name characters of Project Key Number (23 characters and 7 underscores) 
and Sheet Number and Suffix (5 characters) sums to 28 possible characters.   

EXAMPLE FILE NAMES:  Boldfaced text represents the Project Key Number; regular text 
represents sheet number and file extension. 

B_06_1_0064_00_011_2012_S00149                (Folder name)   
B_02_3_0081_08_000_2008_S00150.pdf   (PDF highway plan set) 
B_52_4_0036_00_002_2010_S00151_0010.tif   (TIF file of individual scanned sheet) 
P_47_2_0048_00_073_2005_S00152_0002.tif   (TIF file of individual scanned sheet) 
B_23_3_0010_00_013_2012_S00153_0157.tif   (TIF file of individual scanned sheet) 
R_17_1_0079_00_132_1971_S00156_001_UTM17N83.zip (Compressed Geo-Referenced Tiff)  
 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ S _ _ _ _ _ _ _ _ 

Type 

County ID 

Sign System
 

Route 
Number 

Sub 
Route 

Begin 
Milepost 

Fiscal 
Year 

Unique 
Scan ID 

Sheet 
N

um
ber 
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The following image shows the 19 primary columns the technician will interact with when naming 
a Project Book. (I have minimized the columns you will not be entering the information in for at 
this time.) Each number corresponds to the # column of table 1: 

Reminder: Mandatory columns that MUST be filled out to generate a project key are PlanType, 
CountyID, SignSystemID, RouteNumber, SubRoute, BeginMile, and FiscalYear. These 
columns cannot be more than the provided number length, noted in Table 1. Ex. RouteNumber 
can only be four numbers long. 
 
Table 1:  Data fields of dbo_Scanning database. Boldfaced elements form 30-character Project 
Key. 
 

# FIELD NAME DESCRIPTION NOTES 

1 ID 

Unique 6-
character Scan 
Order Number. 

Single digit location (S, D, X) character plus 
a 5-digit number. The number is 
automatically generated by the database 
when adding a new line. Plans processed 
by the WVGISTC use the letter S. 

2 ProjectTitle 

Name of the 
project that the 
plan represents. 

Generally located on the top center of the 
Project Book. If no title is given on the 
transmittal sheet nor can be found, name 
the project after something relevant, such 
as the county it is in and the route it is on.  

3 FederalProject 

Federal Project 
number. 

Found in the notes section on the 
transmittal sheet. Make sure to enter it 
exactly as written on the physical Project 
Book (generally in the top right corner or 
top center of the plan). 

4 StateProject 

State Project 
number. 

Found in the notes section on the 
transmittal sheet. Make sure to enter it 
exactly as written on the physical Project 
Book (generally in the top right corner or 
top center of the plan). 

5 PlanType 
The type of the 
plan, categorized 
as one of 5 
values. 

Corresponds to “Type” field on transmittal 
sheet. Must be one of the five letter options. 
See table 2 for more information. 



8 
 

# FIELD NAME DESCRIPTION NOTES 

6 CountyID (2 # 
spaces) 

Name of county 
where the project 
is located. 

Referred to by County ID number on 
transmittal sheet. Check physical book for 
county name (generally in the top right 
corner or top center of the plan). See table 
3 for more information. 

7 County2ID 

Name of second 
county, if project 
crosses county 
borders. 

Not listed on the transmittal sheet. Check 
physical book for county name (generally in 
the top right corner or top center of the 
plan). If there are more than two counties, 
add the first two listed. 

8 SignSystemID (1 # 
space) 

Denotes sign 
system. Code 
specified by WV 
DOT.   

Numbers on transmittal sheet correspond to 
a dropdown box in access. If no ID can be 
found or determined, mark as N/A. Refer to 
table 4 for more information. 

9 RouteNumber (4 # 
spaces) 

Denotes the 
project primary 
route number. 

Corresponds to transmittal sheet. If no 
route can be found mark as 0. The middle 
portion of the State Project ID generally 
contains the route number. You can also 
frequently locate the route on the top center 
portion of the cover page. 

10 SubRoute (2 # 
spaces) 

Denotes the 
primary sub-route 
number. 

Corresponds to transmittal sheet. The sub-
route number generally follows the route 
number after a backslash. If no sub route 
can be found mark as 0. 

11 BeginMile (3 # 
spaces) 

Denotes the 
project’s 
beginning 
milepost, as 
stated on the 
project 
cover/index 
sheet. 

Corresponds to the “Begin Milepost” field 
on the transmittal sheet. If no begin 
milepost can be found, mark as 0. The end 
portion of the State Project ID generally 
contains the begin mile value. 

12 FiscalYear (4 # 
spaces) 

Year the project 
was 
commissioned. 

Check physical book for its fiscal year 
(generally in the top right corner of the 
plan). If no year can be found mark as 
9999. Cannot be 0. 

13 District 

District in which 
the county of the 
plan is located. 

Corresponds to transmittal sheet. Check 
physical book for its district (generally in the 
top right corner of the plan). West Virginia 
separates its counties into 10 districts. If 
you can find the county and no district is 
listed, you can use the county name to find 
the district number. If no county or district is 
found, ask the project leader for assistance. 

14 BridgeNumbers 

Denotes relevant 
bridge numbers 
for the project. 

List all bridge numbers for the Project Book, 
found in the “Bridge No.” section of the 
transmittal sheet. If there are multiple 
bridge design or structure identifiers, then 
list in order from lowest to highest. These 
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# FIELD NAME DESCRIPTION NOTES 
are frequently found under the district map 
on the cover sheet but can also be found on 
the plan map itself. 

15 SpecialCodeID 

Denotes a special 
code. Code to be 
specified by WV 
DOT.   

Corresponds to “Special Code ID” on 
transmittal sheet. If no ID is listed mark as 
00. This code is intended to differentiate 
between multiple contracts or projects that 
fall within the same route and milepost. 
Refer to table 5 for more information. 

16 ProjectStatusID 
Denotes Project 
Book Status ID.  

Corresponds to the “Status ID” field on the 
transmittal sheet. Refer to table 6 for more 
information. 

17 BookLocationID Location book 
was scanned 

Mark as “Tech Center.” Change status to 
“DOT” when returned. 

18 PublicationStatusID 

Indicates if book 
has been 
published on the 
website. 

Drop down menu. Corresponds to a binary 
status of “Not Published” and “Published.” 
Leave as “Not Published” when entering 
new plans. 

19 Comments 

Comments on 
Project Book 

Add if necessary. Relevant information 
could include if a plan has no geo-
information, the state of the plan, and 
supplemental pages, etc. 

 ScanCount 
Number of sheets 
scanned in the 
project book. 

Leave blank. This will be added before the 
publishing process. 

 GeoTIFFSheet 

The page number 
of the sheet used 
to create the 
GeoTIFF.  

Leave blank. This will be added before the 
publishing process. 

 SupplementalCodeID 

Denotes a 
supplementary 
code identifier 
which refers to a 
key provided by 
WV DOT. 

Leave as default (00) unless provided by 
the WV DOT on the transmittal sheet. 

 XMax 

The latitude of 
the top corner 
used to hold the 
GeoTIFF in 
correct location 
on map.  

Leave blank. This is generated by the 
publishing script. 

 XMin 

The latitude of 
the bottom corner 
used to hold the 
GeoTIFF in 
correct location 
on map. 

Leave blank. This is generated by the 
publishing script. 

 YMax The longitude of 
the top corner 

Leave blank. This is generated by the 
publishing script. 
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# FIELD NAME DESCRIPTION NOTES 
used to hold the 
GeoTIFF in 
correct location 
on map. 

 YMin 

The longitude of 
the bottom corner 
used to hold the 
GeoTIFF in 
correct location 
on map. 

Leave blank. This is generated by the 
publishing script. 
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The following images notes each of the primary columns, where to find them on the transmittal 
sheet, and where they can most likely be found on the cover page of the project. 
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ENTERING PROJECT BOOKS 
 

1) After you open DOT.accdb, open the dbo_Scanning tab by double clicking it on the 
left side pane. 
a) The database is found in R:\DOT\wvDOT_planROW_scanning\DOT.accdb 
b) Go to the last record in the dbo_Scanning tab. 

i) Right click the scroll bar and select ‘Bottom’ on the pop-up menu to quickly reach the 
last record. 

 
c) If necessary, right click the “ID” column and click sort by smallest to largest. The “ID” 

column corresponds with the “S00000” number assigned to every book. 
2) Assure the Project Books in the folder are together. 

a) Sometimes plans will be unorganized and will need to be reunited with the rest of the 
project. Check that all loose plans are not part of a different plan in the folder. 

3) Fill out the any missing information on the transmittal sheet provided by the WV DOT.  
a) Check the information on the sheet is correct. 

4) Find and copy the Scan Order Number from the ID field in the dbo_Scanning database. 
a) For example, copy Scan Order Number 2115 from the dbo_Scanning table to the 

transmittal sheets as S02115. 
5) Copy transportation field information from the transmittal sheet to the corresponding 

fields in the dbo_Scanning table.   
a) This information is used to generate the Project Key file name (e.g., 

B_06_3_0094_00_000_1964_S02115) which is used to rename all the files during the 
QC/File Renaming process and needed to identify the file name of the Project Book. 

6) Once the Project Book has been entered, move it to its designated location so it can 
begin being processed. 
a) Keep the individual Project Books in order of their Scan Order Number in their original 

folder. 
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CODES / DATA DOMAIN VALUES 
HIGHWAY PLAN TYPES 
Several types of highway plans are scanned, processed, and published by technicians. The 
code must be one of the 5 single letter options in the following table. 
 
Table 2:  Descriptions of several types of highway plans. 
 

PLAN TYPE CODE DESCRIPTION 

ROW Plans R 

Right of way plans show the land obtained by WV DOT to complete 
highway projects.  The right of way portion of the plan set is used to 
convey information about the right of way boundaries and adjacent 
property lines, the property ownerships and acreage involved in the 
takes and the overall impact the improvement will have to the 
particular property owners. Appraisers, negotiators and attorneys all 
use the right of way plans to aid them with their work when 
determining fair market value, negotiating with the property owner or 
explaining a condemnation case to a jury. 

Bridge Plans B Bridge plans show construction and location of a specifics of a bridge 
(e.g., type of girders, type of span, soils). 

Construction 
Design Plans P 

The construction part of the plan set is used to convey information 
about the design of the roadway itself, the amount and type of 
construction materials used for the project and the types of 
construction methods used to complete the work. Designers, 
estimators and construction workers all use the construction plans to 
help them with their work when determining current standards, 
estimating the cost of the project or constructing the improvement. 
Important for maintenance of existing highways.  The construction 
plans are important for maintaining current highways such as re-
pavement projects.  The bridge and shop drawings are tied to the 
planning sheets. 

Shop 
Drawings S 

Shows the way materials were fabricated.  A shop drawing is a 
drawing or set of drawings produced by the contractor, supplier, 
manufacturer, subcontractor, or fabricator.  Shop drawings are 
typically needed for prefabricated components such as the structural 
steel, trusses, etc. 

Half-Sized 
Plans H Half-sized plans show exactly what the contractors were told to build 

or as plans were let to the contractors. 

As Built A 

Revised set of drawing given by a contractor upon completion of a 
project or a job. They reflect all changes made in the specifications 
and working drawings during the construction process, and show the 
exact dimensions, geometry, and location of all elements of the work 
completed under the contract. Also called record drawings or just as-
builts. Typically, the as-built plans found in the District Offices and not 
kept in a consistent and orderly manner. 
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COUNTY CODES 
On the transmittal sheet the county is expressed as a 2-digit code corresponding to one of the 55 
counties in West Virginia. This reflects the county of origin of the project. This code is the numeric 
equivalent of the alphabetized county name list. When entered in the database the county is 
referred to by name.  

Table 3:  Codes corresponding to each county in the state. 

COUNTY NAME CODE 
Barbour 01   
Berkeley 02   
Boone 03   
Braxton 04   
Brooke 05   
Cabell 06   
Calhoun 07   
Clay 08   
Doddridge 09   
Fayette 10   
Gilmer 11   
Grant 12   
Greenbrier 13   
Hampshire 14   
Hancock 15   
Hardy 16   
Harrison 17   
Jackson 18   
Jefferson 19   
Kanawha 20   
Lewis 21   
Lincoln 22   
Logan 23   
McDowell 24   
Marion 25   
Marshall 26   
Mason 27   
Mercer 28   
Mineral 29   
Mingo 30   
Monongalia 31   
Monroe 32   
Morgan 33   
Nicholas 34   
Ohio 35   
Pendleton 36   
Pleasants 37   
Pocahontas 38   
Preston 39 
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SIGN SYSTEM CODES 
The sign system corresponds to the type of roadway the main route of the plan is. Most often 
we use codes 1-4. On the transmittal sheet, the corresponding code is used. When entered into 
the database the long name is used. 
 
Table 4:  The several types of sign systems and their codes. 
 

SIGN SYSTEM CODE LONG NAME SHORT NAME 
0 Municipal Non-State MNS 
1 Interstate Interstate 
2 U.S. Highways U.S. 
3 WV State Routes State 
4 County Routes County 
5 N/A  
6 State Parks and Forest State Parks and Forest 
7 FANS FANS 
8 HARP HARP 
U US Forest Road US Forest 
R WV State Rail Authority Railroads 
T Trails Trails 
9 Other Other 

 
 

 
  

Putnam 40 
Raleigh 41 
Randolph 42 
Ritchie 43 
Roane 44 
Summers 45 
Taylor 46 
Tucker 47 
Tyler 48 
Upshur 49 
Wayne 50 
Webster 51 
Wetzel 52 
Wirt 53 
Wood 54 
Wyoming 55 
Reserved for Other Statewide Continuous features 99 
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SPECIAL CODES 
The DOT sets special codes. If one is not provided, we use “Archived Set.” 

Table 5:  The various special designations and their codes. 
 

CODE NAME 
AA Archived Set 
C(#) Contract 1 (C1), Contract 2 (C2), Contract 6 (C6), etc. 
P(#) Phase 3 (P3), Phase 4 (P4), Phase 5 (P5), etc.  
R(#) R1, R2, R3, R4 (Right of way submissions 1-4) 
S(#) Submission 1 (S1), Submission 2 (S2), etc. 

 

STATUS CODES 
The DOT sets status codes. If one is not provided, we use “Final Design.” 

Table 6:  The various plan status designations and their codes. 
 

CODE STATUS NAME 
1 Initial Design 
2 Preliminary Design 
3 Final Design 

 

SUPPLEMENTAL CODES 
The DOT sets supplemental codes. If one is not provided, we use “Not Applicable.” 

Table 7:  The various supplemental designations and their codes. 
 

SUPPLEMENTAL CODE NAME 
0 Not Applicable 
1 Alternate 
2 Wye 
3 Spur 
4 North 
5 South 
6 East 
7 West 
8 business 
9 North Bound (Business) 
10 South Bound (Business) 
11 East Bound (Business) 
12 West Bound (Business) 
13 Truck Route 
14 Bypass 
15 Loop 
16 Toll 
17 Ramp 
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18 Other 
19 City Streets Non-State 
20 Construction 
21 Footbridges 
22 Historical Bridges 
23 Connector 
24 New/Proposed 
25 Crossover (between dual geometry) 
26 Emergency Crossover 
27 Left Turn Lane 
28 Right Turn Lane 
51 Rail Trail 
99 Abandoned 
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(2)  SHEET SCANNING 
 
Each Project Book will be unbound, and each sheet individually scanned, following all best 
scanning practices as determined by WVGISTC staff, the scanner’s user manual, and the 
specifications described below.   
 
Each page of a Project Book will be numbered sequentially, scanned in the order it is in the book 
with the auto naming feature on. This is to aid WVGISTC technicians and staff during the scanning 
and QC process. Double sided scans will have both sides scanned individually, while trying to 
remove all visible information from the reverse side if possible. This can be aided by placing black 
construction paper behind the sheet inside of a protective cover before scanning.    
 
The document-protection scanning sheath is to be used whenever necessary to protect the 
document and/or scanner.  Conditions when this protective sheath is to be used include: 

• The document is very dirty and might leave dirt in the scanner 
• The document has a waxy coating that may leave residue on the scanner lens 
• The edges of the document are torn. 
• The document is brittle and could be damaged by the scanner. 
• The document is made of a material that is difficult for the sensors in the scanner to 

properly detect, resulting in some scanning errors/inconveniences 
• Any other reason as determined by the scanning technician   

Older sheets tend to need the protective sheath more.  Newer sheets are often made of clean, 
sturdy materials that do not require added protection.   
 
SCANNER SETUP 
 
The scanning software used is SmartWorks Pro for both ColorTrac SmartLF SC 42e Xpress 
Scanners. Turn on the scanner and open SmartWorks Pro scanning software.  Ensure the 
scanner settings are correct. 

SCANNING SETTINGS 
Size 22 x 34 Sheets:  Full Auto Size 

12 x 18 Sheets:  Manual Width with Auto Length 
Width 22 x 34 Sheets:  N/A 

12 x 18 Sheets:  480mm 
Auto BW points Off 
Color Mode 256 Colors with auto palette (8-bit or indexed color) 
Resolution 300 dpi 
Quality 1 
Auto Naming Off or Add Numerical Suffix 
Auto Overwrite Type new name if file exists 
File Name S1XXXX-XXXX.tif 
File Type TIFF LZW 
Folder E:\DOT\Imagery\Original Scans\S1XXXX 

 



20 
 

FOLDER, FILE AND PAGE NAMING 
 
Folder Name: On the scanning computer create a folder named after the Scan Order ID for the 
Project Book being scanned using the computer pathway listed in the above table. 
Scan File Name: The naming convention for individual TIFF digital scans is the Scan Order 
Number followed by the page or sheet number. Example: Sheet number 25 from Project Book 
S12345 should have a file name of S12345-0025.tif. Only numbers should be used in the page 
number, using the auto naming feature of the scanning software. 
Sheet/Page Naming: Use the Add Numerical Suffix of the scanning software to name the 
sheets (or pages) in sequential order automatically.  
 
SCANNING PROCEDURES FOR 22x34 AND 12x18 SHEETS 
 
1) Select the top Project Book Folder from the named books area (from the most recent 

shipment) and bring it to your assigned working pile inside the scanning room. 
a) If there are many Project Books in the folder, it is recommended to move the Project Books 

in smaller sections while preserving the order to the top of the working pile assigned to 
you. This way you can take the Project Books from there to the scanner workstation and 
back without having to move the whole folder from the scanning workstation if you cannot 
finish the whole folder in this session. 

2) Move a Project Book to the scanner workstation. 
3) Write the Scan Order Number (e.g. S12345) with a Sharpie marker on the supplied 

colored paper. 
a) The Scan Order Number is found on the Project Book’s transmittal sheet. 
b) There will be one piece of colored paper per individual Project Book. 

4) Remove clips/tape/staples/sharp objects from sheets and unlatch the binder. 
5) Clean the scanner lens. 

a) Refer to the cleaning section below for more details. 
6) Check that scanner settings are correct.  

a) Refer to the settings table above. Once you set them for the first time you should not have 
to change them again but do confirm each time you start scanning. 

b) On the scanning computer create a folder named using the Scan Order Number from the 
transmittal sheets. Use the computer path name listed in the table above. 

7) Scan sheet. 
a) Wipe the sheets clean and remove any sharp objects or debris as you go to protect the 

scanner and improve the image quality of the scan. 
b) Fix any tears or holes with reinforcement labels or document tape if necessary.  

i) Use a “D-size” document protector found in the map case if sheets are dirty, 
excessively waxy or sticky, too torn, brittle or any other reason it can’t be scanned like 
regular sheet. 

c) Check digital image: Make sure it is straight and free of any streaks or artifacts made by 
the scanner, folds over the neat lines or other data, no information is cut off, or that there 
is any other reason you will have to rescan the page for. 

8) Repeat step 7 until all sheets have been scanned. 
9) After the entire Project Book is scanned, the TIFF scans must be transferred from the 

local workstation to the IncompleteBooks folder. 
a) The file path can be found in the Plan Overview section.  
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b) Mark plan as Yellow on the Performance Tracker when the file has been transferred. 
10) Replace prong fasteners for the Project Book. 

a) Ensure the plan is as securely fastened as possible. 
i) Use new prong fasteners if the old ones are too damaged or otherwise unacceptable. 
ii) After scanning, use document hole punch reinforcement labels to secure loose pages 

with broken prong holes. 
11) Place Project Book within large folder that it originally came from. 

a) Make sure the Project Books are in order in the folder. 
b) If you are not finished with a plan, keep it separated from the plans that are finished and 

the plans that have yet to be scanned in a manner that makes sense to you. Do not leave 
unfinished folders or Project Books on the center scanning cabinets. 

12) When all Project Books in a folder are scanned, write the Scan Order Number range of 
the Project Book Folder with a Sharpie marker on the colored paper provided and tape 
it to the large folder. 
a) One sheet will be the list of all the projects in that large folder, if there are multiple projects 

in one folder add the first and last Scan Order Numbers to that list (e.g. S12345 – S12355) 
13) Clean the scanner lens when you finish scanning for the day. 
14) Update DOT Performance Tracker Google Sheet: 

a) Find relevant Scan Order Number. Mark plan as Yellow when file has been transferred if 
it is not already. 
i) Date of Action 
ii) Technician Name 
iii) Time worked on action (minutes) in the Scanning Time column 
iv) Quantity completed (total number of sheets) 
v) Additional Comments 

b) Complete this process after every completed action. 
15) Update DOT_Operator Tracking Database in MS Access: 

i) Technician performing action 
ii) Scan Order Number 
iii) Action taken 
iv) Date of Action 
v) Time worked on action (minutes) 
vi) Quantity completed (sheets) 
vii) Additional Comments 

a) Complete this process after every completed action or before the end of shift. 
 

SCANNING PROCEDURES FOR 8.5x11 REPORTS 
 
Note:  Disregard scanning the 8.5 x 11 sheet unless WV DOT includes a note to scan the 
8.5 x 11 reports which they consider important.  Guidance from Kevin Huffman on 
6/16/2017. If you are not sure ask the project lead for guidance and further instructions. 
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SCANNER CLEANING AND MAINTENANCE  
 
Clean the scanner before and after scanning for the day and recalibrate scanner at least once a 
month. The lens should be cleaned with a lint-free cloth and specialized lens-cleaning solution. 
The white rollers on the lid that sit on top of the sensor when the lid is closed also need to be 
carefully cleaned, and any other dust, hairs, or debris under the scanner lid should be removed. 
Occasionally, cleaning the scanner lens and rollers will not improve the quality of the scan, which 
will continue to have dark streaks, discoloration, or other issues.  In these cases, it may help to 
recalibrate the scanner. The scanner’s online manual has detailed instructions on how to perform 
calibration. If this also does not improve conditions, there may be more serious maintenance 
issues that will require a visit from a trained technician. It will be important to carefully watch the 
condition of the scanner over the course of this project so that any issues can be swiftly handled.   
 
SCANNING QUALITY ISSUES 
• If images have streaks on them, this means the scanner is dirty.  Delete the image, clean the 

scanner and rescan the sheet. 
• If the scanner is unable to catch a particularly crumpled or frayed sheet either rotate the sheet 

before scanning and rotate it back with Photoshop or place it in a document protector, then 
scan.  
 

SCANNER CLEANING 
1) Click in the latches found on the left and right of the base of the scanner to raise the “lid” of 

the scanner, the scanner must be turned off before cleaning. 
2) Use air duster to remove particulate material by blowing air across the flat bottom surface and 

around support and rubberized rollers. 
3) Remove all residue from all wheels. (Top two tracks of plastic wheels and bottom two tracks 

of rubber wheels. 
4) Clean the roller bar. (Distilled water on a magic eraser.) 
5) Clean the surfaces surrounding the wheels and roller bar to remove any transferred residue. 
6) Clean the lens and close the lid. 
7) Wipe down the top of the lid and surrounding surfaces. (Be gentle on the guideline print as it 

will fade.) 
 

SCANNER CALIBRATION 
1) Open Smart SC Utilities. On touch screen computer, it can be found at c:\Program 

Filesx86\ColorTrac\SmartLFSCUtilities\SmartLFSCUtilities.exe. 
2) Retrieve the calibration sheet from the file cabinet. 
3) Click the calibration button on screen. 
4) Screen will prompt you to insert the calibration sheet into the scanner. Insert the sheet 

exactly as shown. 
5) Click calibrate and wait for scanner to perform the calibration. 
6) Close SmartLF Utilities. 
7) Open SmartWorks Pro. 
8) Scan the calibration sheet and examine the image to check lines are not skewed. Delete 

afterwards. 
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(3)  IMAGE PROCESSING 
 
Image enhancements are performed on scanned images using Adobe Photoshop software to 
improve image quality.  Image processing tasks include manual cropping and an automated Auto 
Contrast function. 
 
Auto Contrast adjusts the overall contrast of an image without affecting its color. Auto Contrast 
maps the lightest and darkest pixels in the image to white and black, which makes highlights 
appear lighter and shadows appear darker. 
 
Scans are cropped in Adobe Photoshop to remove excess white space in the margins and to 
reduce file size. Technicians should crop within an estimated centimeter to the neat line. 
Technicians must be careful to not crop out any information or markings visible on the scan. 
When in doubt, do not crop. 
 
Image enhancement procedures must be performed on the local workstation. Before copying the 
file over make sure to create the proper subfolder structure first. 
 
Each WVDOT Project Book scanned will have its own project folder for holding the TIFFs, PDFs 
and GeoTIFFs.  The folder name will be the unique Scan Order ID for that Project Book, which is 
generated by WVGISTC.   
 
ACTION CREATION PROCEDURES 
 

1) Using Adobe Photoshop software, create an action for Auto Contrast and save. 
a) Open the Window tab > Actions 
b) In the Actions menu, click “Create new action” icon at the bottom. (Green box below) 
c) Name it Auto Contrast and assign a function key (F2). 
d) Press record. 
e) Hold down Alt+Shift+Control keys and press L (Alt+Shift+Ctrl+L). 
f) Then hold down Control+S. (Ctrl+S) 
g) Click the stop icon in the action menu. (Red box below) 
h) This will automate the process of using auto contrast and save the file. Use when 

finished. 
i) This process will not need to be done again   

 
IMAGE PROCESSING PROCEDURES 
 

1) Open File Explorer.  
a) Navigate to the IncompleteBooks folder on \\gistc-

filesrv1\DOTProject\Scanning\IncompleteBooks 
b) Open the Project Book to be image processed. 

file://projectsrv/DOTProject/Scanning/IncompleteBooks
file://projectsrv/DOTProject/Scanning/IncompleteBooks
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c) Create three new folders on your desktop. You will not have to do this more than once. 
Name them as follows: 

(1) GeoTIFF 
(2) PDF 
(3) TIFF 

ii) For every Project Book you do, copy these folders from your desktop and paste them 
into the Project Book folder in the IncompleteBooks folder on the network drive. 

iii) Move the original scans into the TIFF folder. 
2) Copy the Project Book files from IncompleteBooks on to your desktop. 
3) Open the tif files in the TIFF folder in Photoshop by selecting them in the folder on 

your desktop and dragging them to the program. 
4) Making sure you are on the Crop tool, highlighted below.  

a) Shortcut ‘C’ - see Appendix B for more shortcuts.  
b) Align the page by holding Ctrl or clicking the “ruler” icon and dragging your mouse from 

one corner to another on the straightest line possible. 

c) Ensure the text is as level and straight as possible. 
d) If there is no neat line, use your best judgement to find the next best reference. 

5) Crop the image to around a centimeter (estimate it) away from the neat lines by using 
the crop tool while making sure to include any text, diagrams, or additional 
information that is outside the neat lines while minimizing whitespace and the 
scanner background.  
a) If needed, you can use the zoom tool (Z) to get a more precise crop by zooming in closer 

to the edge. Ctrl + 0 will refit the image to the screen. 
b) If there is no neat line, keep the cropping about a centimeter away from any information 

on the page while leaving no white space. 
c) Keep each side of the page as consistent as possible distance wise, excluding any 

information outside the neat lines. 
6) Use the Autocontrast and Save tool by hitting the function key (F2) you assigned it to. 
7) Go to the next page by hitting ctrl+tab or clicking the next file at the top of the work 

area. 
8) Repeat steps 4-7 until finished with all the TIFF files. 

a) As you go, make sure there are no artifacts, folds over the neat lines or other data, no 
information is cut off, or that there is any other reason you will have to rescan the page 
for. 

9) Upload processed images to IncompleteBooks from the folder on your desktop. 
10) Update DOT Performance Tracker Google Sheet: 

i) Find relevant Scan Order Number. 
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ii) Date of Action 
iii) Technician Name 
iv) Time worked on action(minutes) in the Processing Time column 
v) Additional Comments 

b) Complete this process after every completed action. 
11) Update DOT_Operator Tracking Database in MS Access: 

i) Technician performing action 
ii) Scan Order Number 
iii) Action taken 
iv) Date of Action 
v) Time worked on Action (minutes) 
vi) Quantity completed (sheets) 
vii) Additional Comments 

a) Complete this process after every completed action or before the end of shift. 
 
IMAGE SETTINGS AND ENHANCEMENTS 
 
Adjusting the image levels is also useful for removing background noise in the whitespace of a 
scan, and for darkening lines slightly. With proper use of keyboard shortcuts, actions, and 
practice, this step can be performed very quickly and may result in much higher image quality.  
This process can be automated for multiple images that require identical, small adjustments. Any 
TIFFs that might be georeferenced later need to be in Indexed color mode and not grayscale 
mode. They should be in the mode by default if the scanner settings were properly set up.  
  

IMAGE QUALITY ENHANCEMENT SETTINGS OR ENHANCEMENT TOOLS 
Color Mode Indexed Color Mode (256 colors) 
Auto Image Edits Auto Contrast or Auto Levels  
Cropping Manual 

 
COLOR MODE 
The color mode or image mode determines how colors combine based on the number of channels 
in a color model. To reduce file size, the color mode of the image should be Index Color mode 
(256 colors). Indexed Color mode produces 8-bit image files with up to 256 colors and is enough 
colors to match the original document.  
 
AUTOMATED ACTIONS 
 
An action is a series of tasks that you play back on a single file or a batch of files—menu 
commands, panel options, tool actions, and so on. For example, you can create an action that 
changes the size of an image, applies an effect to the image, and then saves the file in the desired 
format. 
 
Actions can include steps that let you perform tasks that cannot be recorded (for example, using 
a painting tool). Actions can also include modal controls that let you enter values in a dialog box 
while playing an action. 
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Photoshop comes with predefined actions installed that help you perform common tasks. You can 
use these actions as is, customize them to meet your needs, or create new actions. Actions are 
stored in sets to help you organize them. See the Adobe Photoshop online help or YouTube 
videos for more information on how to create actions. 
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(4)  PDF BOOK 
 
After image processing has been completed, the edited TIFFs are compiled into a PDF document.  
To do this, an automated script created in Adobe Acrobat Pro is executed to reduce file size and 
create OCR. 
 
For each WVDOT Project Book a single PDF document is created that will hold every scan in that 
Project Book and follows the correct page order.  
 
PDF CREATION PROCEDURES 
 
1) Open Adobe Acrobat Pro. 
2) Change your display theme to dark by going to the view tab on the top left menu 

ribbon > Display Theme > Dark Grey.  
a) You only must do this once. It is important to change this setting to see errors later in the 

process. 
3) Open the Tools tab on the top right of the window. 

a)  On the right side of the screen remove every tool except for Combine Files, Edit PDF, 
Scan & OCR, and Optimize PDF. Your tool bar will look like this: 

 
4) Open the folder with the processed images from the copy of the plan on your 

desktop.  
a) Do NOT work out of IncompleteBooks. 

5) In Adobe Acrobat, click on Tools > Combine files. 
a) Generally, Acrobat can handle ~50 pages of the 22x34 sheets and ~100 of the 12x18 

sheets. This number can vary.  
b) If it cannot handle the number of pages, split the project into however many PDFs as 

needed. (e.g. 400 small sheets should have four 100-page PDFs.)  
6) Highlight all the processed files you want to combine into a PDF in the TIFF folder.  

a) Drag and drop them into Adobe Acrobat with the Combine tool open. 
7) Make sure all files are in the correct order, then click Combine.  

a) The PDF will then be combined creating a tab entitled “Binder1.pdf”.  
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8) In the OCR tools, run recognize text tool > In this File > Recognize Text (Blue button.) 

 
9) Save and name the PDF to match the number of the Project Book (e.g. S12345.) 
10) After that is finished, open the File Optimization tool and run Reduce File Size or 

Compress PDF depending on your software version. 
11) Save and check all the pages for errors. 

a) Make sure that all the pages are the right orientation. 
i) Open the thumbnail view on the left side and use the rotate arrows to correct the 

page’s orientation. 
b) Make sure there are no OCR errors generated from the text recognition process. 

i) The page will look like it has been rotated, sometimes barely noticeable and 
sometimes extremely obvious. These pages will either need cropped to remove the 
generated white space or replaced if cropping is not possible. 

ii) Open the thumbnail view on the left side and right click the page that has the error. 
Replace the page with the processed original page from the TIFF folder. You will 
have to change the file type in the file viewer to All or TIFFs to see the files. Press ok 
when prompted. 

c) Make sure there are no artifacts, folds over the neat lines or other data, no information is 
cut off, or any other reason you will have to rescan and reprocess the page for. 
i) In this case, find the page, rescan it, replacing the page in the OriginalScan Project 

Book folder. 
ii) Upload that individual file to the IncompleteBooks folder and replace the former scan. 
iii) Process the new page in Photoshop as usual. 
iv) Replace the old page in the PDF with the new page you rescanned. 

12) If there are multiple PDFs from too many pages, repeat steps 5-11 till all pages have 
been built into a PDF. 
a) Combine them into one singular PDF using the Combine tool, making sure they are in 

the right order. There should only be one PDF in the incomplete books folder.  
b) Save and name the PDF to match the number of the Project Book (e.g. S12345.) 
c) Re-run the Reduce File Size or Compress PDF tool. 

13) Upload finished PDF to IncompleteBooks from your desktop. 
14) Update DOT Performance Tracker Google Sheet. 

a) Find relevant Scan Order Number. 
i) Date of Action 
ii) Technician Name 
iii) Time worked on action(minutes) in the PDF Time column. 
iv) Additional Comments 

b) Complete this process after every completed action. 
15) Update DOT_Operator Tracking Database in MS Access: 

i) Technician performing action 
ii) Scan Order Number 
iii) Action taken 
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iv) Date of Action 
v) Time worked on Action (minutes) 
vi) Quantity completed (sheets) 
vii) Additional Comments 

a) Complete this process after every completed action or before the end of shift. 
 
 
PDF RESOURCE NOTES 
 
OCR Sheet Rotation:  The automated Recognize Text process involves a step that automatically 
straightens the image by rotating it so that most of the text lies perfectly horizontally. This 
occasionally results in errors, such as the image being rotated to match non-horizontal text so 
that the scan now appears crooked, or the image being rotated a full 90 degrees to match text 
that appears vertically.  Because of this, each page of the PDF needs to be inspected after the 
Recognize Text tool is run, and any errors corrected.  For slightly crooked images, the correction 
will require removing the erroneous page and inserting it into the correct place within the PDF 
WITHOUT running the Recognize Text tool on that page (since that will result in it being crooked 
again).   
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(5)  GEOREFERENCING HIGHWAY INDEX MAP 
 
Technician will use Photoshop, Google Maps, and ArcGIS to find and geo-reference each Project 
Book index map to UTM Zone 17N projection, NAD83 Datum.  The target object to be 
georeferenced is typically found on the first page and is contained in the index map, but it can be 
found in various places throughout the Project Book. The page that has the object to be 
georeferenced must be copied from the TIFF folder and then pasted into the GeoTIFF folder. 
 
ARCGIS PRO SETUP 
 
1) Open ArcGIS Pro and log into your account. 

a) Make sure the program is up to date. You might need admin permissions to do this, so 
ask the project lead for help. 

2) On the start screen, create a new map by clicking on the first icon labeled “Map”. 
a) When prompted, name the project “DOT_GR”. This will now open the ArcGIS interface. 

3) Once the interface is loaded, click the arrow underneath “Connections” in the Insert 
tab, hover over the “Server” option, and click “New ArcGIS Server” 

4) Paste this link in beside the “https://”: 
a) services.wvgis.wvu.edu/ArcGIS/services 
b) Press OK. 

5) On the right of the screen should be the catalog pane.  
a) If not, click View > Catalog Pane.  
b) There, click the server folder option, and then the ArcGIS server you added. Open that 

and the Imagery_BaseMaps_EarthCover folder.  
c) Drag and drop the wv_imagery_WVGISTC_leaf_off_mosaic into the contents pane on 

the left. 
6) Right click “Map” under drawing order on the contents pane on the right of your 

screen and click properties. 
a) Click Coordinate systems in the map properties window. Navigate to Projected 

Coordinate Systems > UTM > NAD1983 > NAD1983 UTM Zone 17N. Click on it and 
press ok. 

7) Once out of the properties window, change your base map to the “Streets” option on 
the Map tab of the tool ribbon using the Base Map button. 

8) Save the project and find the folder in C:\Users\YOUR 
USERNAME\Documents\ArcGIS. 
a) Right click the “DOT_GR” folder and pin it to your quick access bar as instructed in the 

beginning of the manual. 
9) You will only need to do this set up once. 

 
GEOREFERENCE PROCEDURES 
 
1) Select the best single TIFF file from the TIFF folder on your desktop.  

a) This is preferably the cover page, but not always.  
b) Open the file in photo viewer. 

2) Copy the selected file into the GeoTIFF folder on your desktop. 
a) Exception to the cover page include:  
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i) Maps that are larger than 1 inch to 3 miles scale or it covers more than 3 counties. 
(1) If between 2-3 miles or 1 inch to 2000ft and 3000ft, crop the page down to just the 

map on the cover page. 
ii) Maps without cover pages. Find the next best page that shows as much of the plan as 

possible and use that. 
iii) Maps without any geo-information of a reasonable scale. The last resort is to crop out 

the inset map and georeference that. 
iv) Maps without any geo-information at all. Comment on the Performance Tracker that 

the plan has no geo-info. Move to step 15. 
3) Drag the TIFF into the Table of Contents from the GeoTIFF folder on your desktop. 

a) A prompt will appear asking if you would like to create pyramids and statistic information. 
Check the boxes to have it automatically perform this. Click yes. You will only have to do 
this once. 

b) Make sure to place it above the imagery layer so you can see the plan. 
4) In the Raster Layer tab and change the Transparency to ~30%. 
6) Use the image you opened earlier to look for spatial references to match to the image 

in Arc such as roads, rivers, crossroads, etc. 
i) You can use Google maps to aid you in looking for the area if needed. 
ii) Sometimes inserting the map and orienting it properly can help you find it. Refer to 

step 7 on how to do this. 
a) First, find the county the plan is in by referencing the top right corner map. Zoom to this 

county in ArcGIS. 
b) Next, use the inset map to find the more precise location in the county where the project 

is. It will often be depicted by a line, arrow, or circle. 
c) Once you have the general location, refer to project plan itself. 
d) For sheets depicting little to no spatial information, use these clues to aid in 

georeferencing: 
i) A North Arrow will aid in orienting the page correctly (Top left corner of example 

below.) Rarely the north arrow will be oriented incorrectly but normally it is correct. 
ii) Project Title often has more information corresponding to the location of the project, 

i.e. “Rafe Run Bridge.”  
iii) The scale bar can help you determine how small the plan is.  
iv) The DOT Access database “dbo_Scanning” can also supply more information 

concerning any routes/sub routes and other information. Ask the project lead for this 
information or consult the transmittal sheet attached to the physical Project Book. 

v) Another tip for reading DOT book plans. Roads that are dashes are generally the old 
roads and the solid line with the circles and dashes are the proposed plan and should 
be georeferenced rather than the dashes, unless it does not match.  

e) If the cover sheet does not supply enough spatial information, try to find a sheet in the 
project that does, but it should be a last resort.  
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i) If there are no sheets that can be used, leave an empty GeoTIFF folder in the Project 
Book folder. Leave a comment saying “No Geoinfo” in the Performance Tracking 
Sheet.       

7) Once you have found the area to which you plan to reference the image click 
Georeference from the Imagery tab and click Fit to Display. 
a) Use the Rotate tool on the image to orient it using the north arrow and use the Move and 

Scale tools to help you get it into the general position. Do not go for perfect accuracy as 
that can make it more difficult to add control points. 

8) Once set in place, click the “Add Control Points” button and add control points as 
necessary. 
a) Always assign control points using the imagery and not the base map. 
b) When you first click to add a control point, click on the section of the map itself and then 

on the corresponding point on the imagery.  
c) Add at least four (4) control points and make sure the main portion of the project (Usually 

outlined in sections of boxes) is what is being georeferenced (e.g. if the plan is an 
Interstate, match the Interstate road, and not the side roads.) Do not exceed ten (10) 
control points. 

d) Sometimes a point will not work as you wanted or will need removed.  
i) To do this, select the point by clicking the select tool in the review section of the 

Georeference tab. Once the point is selected, click on the Delete tool. These tools are 
highlighted in green. 
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ii) If you only have one other point placed, this will transform the image to make it 
ridiculously small. You can either reset the image and start over or try to carry on if 
you think you can match the point well enough. It will automatically transform the image 
for you.  

9) General Tips: 
a) The north arrow is not always oriented perfectly or correctly even, if you are having 

difficulty finding a location, try orienting the map in different directions. 
b) Check that you are trying to georeference the correct line on the map. Often the plan will 

be misleading and show the old part of the project in a more precise manner as the part 
you are most likely georeferencing had not been built yet. Generally, they will represent 
the new part with a bold line with dashes and circles throughout. Sometimes they will label 
it but not always. 

c) The scale bar can give you a hint as to how small or large the plan needs to be. Using the 
scale of the map on the bottom of ArcGIS Pro you can tell how zoomed in you should be 
before you fit the map to the display. 

d) Do not try to make every map as perfect as possible. Some maps are not scaled correctly. 
Sometimes it is the whole map, and sometimes it is part of the map. There are also times 
where the plan was not built as planned or perhaps not at all. Obviously, we want the best 
match we can get, but redoing the map over and over is a waste of your time. 

e) If you cannot find the location, ask for a second opinion. This is a skill that you develop by 
doing and will take time to get the hang of. 

10) Once done, click “Save as New” in the Georeference tab 
a) Set the Output Raster Dataset to your project folder that should be pinned to your quick 

access bar. It should default to this. 
b) Make sure the coordinate system is set to NAD_1983_UTM_Zone_17N. 
c) Leave Geographic Transformations, Clipping Geometry, and Cell Size as it is. 
d) Change the raster size columns and rows to 6000. The cell size will change when columns 

and rows changes. That is fine. 
e) Leave Pixel Type alone. 
f) Change NoData to 0. 
g) Leave everything else as it is. 
h) Click Export 
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i) This image has what it should look like:  

11)  When exported, you will find four files in the project folder pinned to your quick 
access bar on your file viewer.  
a) Rename them all to S1XXXX-[FILENUMBER]_UTM17N83 (e.g. S10899-

0001_UTM17N83).  
i) The bottom two files will select the extra file extensions, make sure you keep all of 

them and only rename the file itself. 
b) It is a hyphen between S1XXXX and [FILENUMBER] and an underscore between 

[FILENUMBER] and UTM17N83. The [FILENUMBER] is FOUR digits. 

12) Select all four files, right click on the .tif file with them all selected and click “Send to 
Compressed (Zipped) Folder”.  
a) Make sure the zipped folder is named the same as files and the file type is ONLY “.zip”. 

(e.g. S02939-0028_UTM17N83.zip) 
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13) Put the zipped file into the Project Book GeoTIFF folder on your desktop.  
a) Delete the copy of the .tif and the two files generated in the GeoTIFF folder by ArcGIS 

Pro when you loaded the image into the map. 
b) Delete the four tiff files and the .zip file from the DOT_GR project folder. 

14) Upload finished GeoTIFF to IncompleteBooks from your desktop. 
15) Update DOT Performance Tracker Google Sheet. 

a) Find relevant Scan Order Number. Mark the number as green. 
i) Date of Action 
ii) Technician Name 
iii) Time worked on action(minutes) in the Georeferencing Time column. 
iv) Additional Comments 

(1) If the plan was particularly difficult to georeference, explaining why the specific 
location was chosen.  

(2) Leave a note if the page could not be georeferenced and mark time as N/A. 
b) Complete this process after every completed action. 

16) Update DOT_Operator Tracking Database in MS Access: 
a) If there was no Geoinfo, do not log anything in the Access database. 

i) Technician performing action 
ii) Scan Order Number 
iii) Action taken 
iv) Date of Action 
v) Time worked on Action (minutes) 
vi) Quantity completed (sheets, always one sheet for georeferencing.) 
vii) Additional Comments 

b) Complete this process after every completed action or before the end of shift. 
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(6)  QUALITY CONTROL & FILE RENAMING 
 
Due to the complexity in the several earlier processes, a special emphasis is placed on quality 
control and assurance to confirm that the technicians are supplying the best possible product. 
The technician will check for accuracy and completion of the Database entry, filename, image 
processing, PDF, and GeoTIFF. Upon completion, the technician will use the file renaming tool to 
rename the quality assured folder in the IncompleteBooks folder. Once renamed, it will be moved 
to the ProjectBookFolders folder.  Technicians cannot Quality Control their own work. 
 
QUALITY CONTROL PROCEDURES 
 
1) Navigate to the IncompleteBooks folder and choose a folder to QC. 
2) Open the TIFF folder: 

a) Check that all files are accounted and that the quantity listed is correct.  
b) Check that there are no non-TIFF files in the folder. 

3) Open the PDF folder and open any PDF’s within the folder.  
a) There should only be one which has the whole plan. Delete any extra PDFs. 
b) Check the PDF to make sure it has the correct number of pages.  

i) If there are discrepancies with the page number, flag the file on the Performance 
Tracker describing the problem. 

c) Check that all pages have been image processed. 
i) Check that no information has been cropped out or has folds over it, the page is 

cropped within approximately a centimeter along all neat lines and information outside 
the neat lines, and the page is reasonably straight.  
(1) If there are discrepancies, flag the file on the Performance Tracker noting which 

pages need processed or fixed. 
d) Check that all pages face the correct direction. 

i) If there are discrepancies, flag the file on the Performance Tracker noting which pages 
need rotated. 

e) Check that no pages are askew or have OCR errors. 
i) If there are discrepancies, flag the file on the Performance Tracker noting which pages 

need replaced. 
f) Check that no pages have artifacts or other imperfections that do not come on the original 

plan. 
i)  If there are discrepancies, flag the file on the Performance Tracker noting which pages 

need examined or rescanned. 
g) If there is an error and you are sure it needs fixed mark the whole plan section as red. If 

you are unsure there is an issue and need more information mark the whole plan section 
as orange. 

4) Open the GeoTIFF folder and extract all files into the GeoTIFF folder. 
5) Open ArcGIS Pro and your DOT_GR project. 

a) Drag the TIFF file into the Table of Contents. 
b) Right click that layer and click on Zoom to Layer. 
c) Check that the Georeferenced index page matches the area to which it is referenced. 
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i) Ensure that the Georeference does not cover a large amount of a county/state. (Over 
1in:3m scale or covers more than 3 counties.) 

ii) Ensure that the Georeference does not have a black background (No data not set to 
0.) 
(1) Flag the file on the Performance Tracker noting the issue with the GeoTIFF. 

d) After confirming that the georeference is correct, remove the GeoTIFF from ArcPro. 
i) Select the extracted files that make up the GeoTIFF in the GeoTIFF folder in the 

IncompleteBooks folder and remove them.  
(1) Make sure the GeoTIFF .zip folder and the subfiles are named correctly. If not, flag 

this and have the technician rename them properly. 
6) Once the Project Book is verified as complete, move to the renaming process. 
 

FILE RENAMING TO PROJECT KEY 
 
SET UP PROCEDURES 
 
1) Open File Explorer: 

a) In the Show/Hide section of the View ribbon, check the ‘File name extensions’ box.  
b) Click the View tab > Options. A ‘Folder Options’ panel will open. 

i) Click the View tab on this panel. In the Advanced settings box under Files and Folders 
check the ‘Always show icons, never thumbnails’ box. 

ii) Under Hidden files and folders check the box ‘Show hidden files, folders, or drives’ 
iii) Uncheck the “Hide protected operating system files (Recommended)’ box. 

(1) A Warning will pop up, click Yes. Click Apply. 
2) You will now be able to see the Thumbs icons within various folders (They may not 

always be present, however).   
a) To successfully rename a folder, you must remove all “Thumbs.db” files from the folder. 

3) Some of the settings for the following steps might be complete already, check to make 
sure they are. 

4) Open Start: 
a) Search for ‘gpedit’ and click the top result to open the Group Policy Editor. 
b) Click on User Configuration from the left pane. 
c) Browser the following path: Administrative Templates > Windows Components > File 

Explorer. 
d) Double-click the Turn off the caching of thumbnails in hidden thumbs.db files policy. 
e) Select the Enabled option to disable the feature. 
f) Click the Apply button. Click the Ok button. 

5) Open Start: 
a) Search for regedit, right-click the top result, and select the Run as administrator option. 
b) Browse the following path: HKEY_CURRENT_USER > Software > Policies > Microsoft > 

Windows 
c) Right-click the Windows folder select the New submenu and click on Key. 

i) Name the key Explorer and press Enter. 
d) Right-click the newly created key, select the New submenu, and click on the DWORD (32-

bit) Value option. 
i) Name the DWORD DisableThumbsDBOnNetworkFolders and press Enter. 
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ii) Double-click the newly created DWORD and change its value from 0 to 1. 
e) Click the OK button. Restart your computer. 

6) You should now be able to remove “Thumbs.db” files without the “The action can’t be 
completed because the file is open in Windows Explorer” message. 
 

RENAMING PROCEDURES 
 
1) Navigate to the IncompleteBooks folder and find the folder to be renamed. 
2) Open the folder and remove any “Thumbs.db” from the Project Book folder and its 

subfolders. 
a) Make sure it has all three of the subfolders (GeoTIFF, PDF, TIFF) or else the tool will not 

run. 
b) Navigate out of the folder to be renamed. 

3) In the DOT Access database open the dbo_vw_ProjectKeyLookup. 
a) Locate the Scan Order Number of the plan you are renaming. The corresponding key is 

what you need. 
4) Open ArcGIS Pro: 

a) In Arc, click “add folder” and connect to R:\DOT\wvDOT_planROW_scanning\Scripts. 
b) Expand Pro_DOT_Tools.tbx to find the DOT File Rename for Pro Tool. 

i) Open the File Rename Tool and type in the name of the folder to be renamed exactly 
as it appears in the IncompleteBooks in the Old Project Key box of the Rename Tool 

ii) Copy the ProjectKey of the folder to be renamed from Access and paste it into the 
New Project Key box of the Rename Tool. 

iii) Make sure the ProjectBook Structure box is checked. 
iv) Run the tool with the Validation Only box checked. 

c) If there are no issues with the validation, uncheck the box and run the rename tool. 
5) Check to ensure the files renamed properly in all the subfolders and inside the GeoTIFF 

.zip file. They will look like this: 
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6) After the file has been properly renamed, it must be moved from the IncompleteBooks 
folder to the ProjectBookFolders folder.  
a) Drag the correctly renamed book in the IncompleteBooks folder and drop it in the 

ProjectBookFolders folder. Mark the plan number Blue on the Performance tracker noting 
it has been QC’d. 

b) If there was an issue with renaming the file, mark the plan number Light Blue. 
i) The most likely error is a permission error. Have the technician who processed the 

plan restart their PC. 
7) Update DOT Performance Tracker Google Sheet. 

a) Find relevant Scan Order Number 
i) Date of Action 
ii) Technician Name 
iii) Time worked on action(minutes) in the QC Time column. 
iv) Additional Comments 

b) Complete this process after every completed action. 
8) Update DOT_Operator Tracking Database in MS Access: 

i) Technician performing action 
ii) Scan Order Number 
iii) Action taken 
iv) Date of Action 
v) Time worked on Action (minutes) 
vi) Quantity completed (sheets) 
vii) Additional Comments 

b) Complete this process after every completed action or before the end of shift.
 

Note:  When running the rename tool, make sure you are outside the folders when in the 
Project Book. You can be inside the Project Book but not in TIFF, PDF, or GeoTIFF. 

- If there are any issues with the validation, address them and run the validation again. 
 
POSSIBLE ISSUES WITH RENAMING: 
 
1) Thumbs in the TIFF folder and GeoTIFF folder.  

a) Delete the thumbs.db file. 
2) File Permission Error- does not rename Folder but renames sub folders and files. 

a) Have the technician restart their computer and manually rename the main folder the 
project key. If you re-run the renaming tool it will mess up the GeoTIFF .zip. 

3) File type Suffix on the end of the of the compressed GeoTIFF folder. 
a) Be sure that the compressed zip in the GeoTIFF folder does not include any suffixes, such 

as .tif /.aux or any other combination that is not just ‘.zip’ These suffixes lead to error on 
the website’s download GeoTIFF action. 
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(7)  PUBLISHING (includes WEB QC & BACKUPS) 
 
Highway Plans Locator website: www.mapwv.gov/DOTplans 
 
The Highway Plans Locator website is one of the final products achieved in the West Virginia 
Division of Highways Scanning Project. The files are organized in a geodatabase that houses 
several image and feature services to make data available to the webpage. This section of the 
Scanning Project Procedures will outline the use and function of the scripts and database layers 
that construct the web map service. 
 
The DOT Project Plan Scanning system is designed around an operational database used for 
recording scanning activity and an enterprise geodatabase used to support web mapping and 
image services. The system takes advantage of the multi-user capability of Microsoft SQL Server 
2012, allowing scanning information to be recorded in real-time and new scans to be published 
as they are created. 
 
In addition, the use of an enterprise geodatabase streamlines the process of updating the ArcGIS 
feature and image services by eliminating the need to re-publish an entire ArcGIS geodatabase 
in order for updates to be made available on the web. 
 
DOT GEODATABASE OVERVIEW 
 

The ArcMap project used for feature and image service publication is named DOT.mxd. 
This project defines the related feature classes, raster mosaic, and database tables. It also 
defines the standard symbology and related database connection information. This ArcMap 
project is stored on a production file server in the WV GIS Technical Center and is backed up on 
automated schedule (Figure 1). 

Figure 1: ArcMap / ArcCatalog Listing of the Arc Project and related toolbox items 
 
 

http://www.mapwv.gov/DOTplans
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The supporting ArcGIS enterprise geodatabase has three primary objects:  
1) A raster mosaic used as the source for the ArcGIS image service. 
2) A feature class representing map footprints of each scanned construction plan. 
3) A database view that is used as the underlying source for the published plans and for the 
web-based query interface.   
These can be seen in the following screenshot taken from the ArcMap Catalog interface. 

Figure 2: DOT enterprise geodatabase structure. 
 
The vw_DOT_Scanning view is used in ArcMap as the layer source for the Footprint map 
service. The DOT database, which stores scanning information and related lookup tables, is 
used on the website to provide this information to the user. This view links the ArcGIS feature 
class inform to the operational scanning data. The view is defined as follows: 

Figure 2: Feature service symbology and ArcGIS hosted services  
 

Mosaic used 
for image 

Feature class 
containing 
footprints 

View that is 
published as 
the map 

i  

vw_DOT_Planfinder view definition in ArcMap: 
CREATE VIEW vw_DOT_Planfinder AS  
  SELECT OBJECTID 
  ,Name 
       ,[Shape]  
  , Scanning.* 
   FROM GDB_DOT.dbo.DOT_Planfinder_Footprint 
    JOIN DOT.dbo.vw_Scanning AS Scanning  
   ON  Scanning.ScanOrder = 
DOT Planfinder Footprint ScanOrder 
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The structure of the DOT database used to store scanning information and related lookup 
tables can be viewed from within ArcMap or Arc Catalog. All administration for this database is 
performed using Microsoft SQL Server Management Studio. Backup plans are defined from within 
the management interface and scheduled backups are run using the SQL Server Agent process. 

Figure 4: DOT Database table listing 
 
Since the Map Service and Image Service are fed from a SQL Server enterprise geodatabase 
(dbo_Scanning), it is not necessary to re-publish any services to add new scan rasters to the 
ArcGIS Services. All that is needed is to add them to the raster mosaic and update the footprint 
feature class.   
 
PUBLISHING GEOTIFFS 
 
The georeferenced TIFFs from each Project Book will be combined into raster mosaics in ArcGIS 
for easy viewing.  To add scan rasters to the mosaic they first need to be placed in the proper 
folder, this is accomplished using the Publish GeoTIFF python tool. Expand the tool named 
PublishGeoTIFF.pyt python tool and open the DOT GeoTIFF Publishing Tool. 
 

 

DOT GeoTIFF Publishing 
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Double-Click DOT GeoTIFF Publishing Tool to open the script, the following box will appear: 

 
The Root Folder needs to be:  
\\gistc-filesrv1\DOTScanning\Scanning\ProjectBookFolders 
The Target Folder needs to be:  
\\gistc-filesrv1\DOTScanning\Scanning\tiffs 
 
To add scan rasters to the mosaic they first need to be placed in the Target Folder. This tool 
extracts the GeoTIFFs from the zipped versions in the individual Project Book folders that are 
created during the scanning process. These zipped images are in the Root Folder specified 
above. The tool can process a single Project Book folder or optionally all folders. If a Project Key 
value (For example, “B_02_1_0081_00_012_2001_S01614”) is specified, then only the 
corresponding GeoTIFF will be published. If the Project Key value is left blank, then the GeoTIFF 
files for all projects will be extracted to the production folder. You can only do one at a time, but 
the process is much faster this way. 
 
Click OK and the Tool will run, placing all the GeoTIFF folder contents from \ProjectBookFolders 
into \tiffs so that they can be added to the Mosaic dataset.  
 
This step takes a long time to run if you do not individually process projects. (approximately 6 
hours as of 10,000 plans), so plan accordingly. Check to see the website is running after it 
completes. 
 
ADD RASTERS 
 
The next step takes the GeoTIFF rasters we previously extracted and adds them to the mosaic 
dataset. This is needed so we can build the footprints and display the georeference on the web 
map.  
 
The first step is to right click on the feature dataset DBO_planfinder and select Add > Rasters.  
 

GDB.DOT.DBO.DOT_Planfinder 
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The following interface will appear: 

 
The Mosaic Dataset needs to be:  
\\gistc-
filesrv1\Projects\DOT\wvDOT_planROW_scanning\Scripts\GDB_DOT.sde\GDB_DOT.DBO
.DOT_Planfinder 
 
Normally, when adding rasters to the mosaic, the “File” option should be selected in the “Input 
Data” section of the “Add Rasters” dialog. Each raster can be selected individually and added to 
the “Source” list. It is important to use the full pathname so that the ArcGIS server can access the 
images. 

 

Insert the file path (As shown) of 
the GeoTIFF(s) you need to add 
here. They will be added to the list 
b l  
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Under the Advanced Options, the “Add New Datasets Only (optional)” drop down should be set 
to “EXCLUDE_DUPLICATES”. 
 

 
If needed, the mosaic can be loaded from scratch by selecting the Workspace option instead of 
Raster dataset under Input Data. The technician must enter the file path of the folder we previously 
extracted the GeoTIFFs to.  
 
The Input Data Workspace needs to be:  
\\gistc-filesrv1\DOTScanning\Scanning\tiffs 
 
Click OK to run the tool and add the GeoTIFFs extracted in the last step to the mosaic dataset. 
This process takes approximately 30 minutes as of 10,000 plans. Check to see the website is 
running when it completes. 
 
BUILD FOOTPRINTS 
 
When added to a data frame in ArcGIS, each raster mosaic contains three layers, one of which 
is called Footprint. This is a vector layer of rectangles drawn around the extent of each raster, 
and attributes for each raster are stored here in the attributes table. 
 
After the rasters are added to the mosaic dataset, the footprints of each georeferenced image 
need to be created. The next tool removes all existing footprints then rebuilds the feature class 
by scanning the rasters and generating new features. This is done using the BuildFootprints 
python tool. Expand the tool named BuildFootprints.pyt and open the DOT GeoTIFF Publishing 
Tool.  

 
 
 
 
 

DOT Footprint Builder 
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The following interface will appear: 

 
 
The Mosaic Feature Class needs to be:  
DOT.sde\GDB_DOT.DBO.AMD_DOT_Planfinder_CAT 
The Output Feature class needs to be:  
GDB_DOT.sde\GDB_DOT.DBO.DOT_Planfinder_Footprint 
 
Open the tool and click OK. Expect it to take around an hour minimum as of 10,000 plans. 
Check to see the website is running when it completes. 
 
UPDATE FOOTPRINTS 
 
Currently, the footprint layers from each of the mosaics get merged into a single, separate 
Footprints layer and stored in a file geodatabase. This supplies a single attribute table for every 
raster in each mosaic, making it much easier to search for and view data relating to all raster’s at 
once.  
 
This process will call upon the ProjectKey and the GeoTIFFSheet. ProjectKey will have the Project 
Key for each raster in the Footprints layer, and GeoTIFFSheet will contain the sheet number as it 
appears appended to the Project Key in the filename of the GeoTIFF (including the underscore).  
These two fields are used to create links in ArcGIS.com to our FTP server and facilitate joining 
the WV DOT Project Database to the Footprints attributes table. 
 
The technician needs to copy the footprint extents into the dbo_Scanning table using the 
UpdateFootprintExtent.pyt toolbox and the associated DOT Footprint Extent Update script.  

DOT Footprint Extent Update 
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It is important to note that the DOT Footprint Extent Update tool will only run on the plans that are 
specified in the Scan Order row, to update all Scan Orders, follow the directions in the tool and 
place an asterisk (*) in the Scan Order row. It is also necessary to check the “Update Database” 
checkbox at the bottom of the dialogue box to properly update footprint extents. If this box is left 
unchecked, then the tool will function as a test and will not copy any information from the image 
service into the database.  

Click OK and the tool will populate the XY coordinates in the database. This should take no more 
than 10 minutes as of 10,000 plans. Check to see the website is running. 
 
PUBLICATION STATUS 
 
The raster mosaics and the Footprints layer are currently being published as a GIS service in Arc, 
and then added to a map on the ArcGIS.com map viewer. This is mostly for demonstration 
purposes but is also useful as a means of sharing the materials with WVDOT, tracking the 
project’s overall progress, and making it viewable in an interactive environment.  
 
To publish the service, the user must have access to various server addresses on the WVGISTC 
network, which will likely require admin permission. The server addresses themselves are subject 
to occasional changes; verify which server the service should be published on before continuing.  
  
The last step is to update the PublicationStatusID column of the Scanning table to ‘2’ or if you are 
using the Access interface open the table and set the PublicationStatus to ‘Published’. 
 
At this point you should be able to see the new footprints on the website, check to see that it is 
running. 
 
FINAL WEBSITE QC 
 
After the Publication Status is changed to Published, all links on the website should working. 
However, there are several different scenarios that cause the links to fail. A final quality control is 
to be completed by the technician who has updated the website.  
 
1) Navigate to the website: http://mapwv.gov/DOTplans/ 
2) Search for one specific plan at a time, which you published in the last batch. 

a) Click and check each of the four links for each Project Book.  

Make 
sure to 
check 
this 
box 

http://mapwv.gov/DOTplans/
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3) Note any errors that are found in the Web QC Google Sheet.  
a) Refer to Website Troubleshooting for information about errors.   

4) Make any corrections and continue to Backup procedures. 
 
WEBSITE TROUBLESHOOTING 
 
1) If the PDF works and the Globe does not: 

a) Look to see if book is named correctly: 
i) Check to see if the GeoTIFF zip file name matches the dbo_vw_Projectkeylookup 

name. 
ii) Check to see if the Georeference page number matches the column under 

dbo_scanning > GeoTIFFSheet (this can only have 3 number characters.) 
iii) Check to see if the coordinates are properly populated. 

(1) If the book name matches, and the Georeference page is correct, see if the date 
is 0 or not populated. If so, you will need to remove the old tiffs in the tiffs folder, 
rename all related files to include the “9999” date (including the zipped GeoTIFF 
files,) and wait for republishing.  

(2) This can apply to any field that has specific parameters, such as the route number, 
sub route number, and begin mile number. Check those fields as well. 

b) Look to see if there is a file or folder issue: 
i) Go to the GeoTIFF folder within the problem book and check to see if the zipped file 

folder is within another folder. Removed zipped folder and place it inside GeoTIFF 
folder. 

ii) Check that the zipped folder has all four of the required files and is not missing any. If 
it is missing files, it will need georeferenced again. 

2) If the PDF does not work and the Globe is not there: 
a) Check to see if the PDF file name matches the dbo_vw_Projectkeylookup name. 

3) If the download GeoTIFFs (scenic portrait button) does not work: 
a) Check the GeoTIFF zip file-pathname. Make sure that the folder does not include the 

ending “. aux.zip” 
4) If footprints display but raster mosaic does not appear or the Georeference otherwise 

does not display properly: 
a) Search the Project Book number in the \tiffs folder and remove all tiffs associated with that 

plan. 
b) Remove any associated rasters from GDB_DOT.sde. 
c) Complete the Website Publishing Procedures. 

 
Important: To get rid of duplicate book numbers when uploading to the website go to the \tiffs 
and remove the TIFFs in the folder. When adding rasters, go to advanced settings in the dialog 
box and check “exclude duplicates”. 
 
Record work in Web QC Status Google Sheet. 
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BACKUP PROCEDURES  
 
EXTERNAL DRIVE 
The external drive is to be backed up by one technician at the end of web QC process. After being 
backed up, a transmittal sheet should be updated and saved to the external drive DOT Scanning 
folder, which records the date of backup, Project Books included, and the amount of storage used. 
The transmittal sheet can be found on the external drive being used to back up the scan data.  
 
INTERNAL SERVERS 
The internal backup is performed along with the WVGISTC’s general server backup.  
 
DIGITAL PLAN PROCEDURES 
 
In case of digital plan submissions of previously scanned images from WV DOH District offices, 
technicians will follow the procedures as outlined below. This method is subject to change as 
digital plan submission formats and procedures change.  Digital submissions may affect the 
following work tasks: 
 

• File Naming 
• Image Processing 
• PDF Creation 
• Georeference Plan Index Map Sheets 
• Quality Control/Quality Assurance 
• Publishing Web Map 

 

 
 
 
  



14 
 

APPENDIX A:  Page Number FAQ 
 
Page Numbering FAQ 
The following Q&A’s are examples of page numbering questions/inconsistencies that have arisen 
during the scanning project.  New questions are added to the document as problems are 
discovered, and answers are added as they are received.  
 
Q: Pages are arranged out of order. 
A: Rearrange the pages by the official page number as seen on the sheet.  If there are pages 
from different projects within the same book which are numbered by a different system/sequence, 
retain the order in which those pages were physically found when creating the PDF document, as 
they were likely placed in that order intentionally by WV DOT.   
Q: Two pages with different content, but same page number. 
A:  They might be from different projects.  If so, keep the order in which they were found, keeping 
the same file name and allowing the scanning software to auto number the pages. 
There is also a chance the pages were miss-numbered.  Example: 17, 18, 20, 20…  In a case like 
that, correct the page numbers in the file name (in the example, you would change the first 20 
into 19), keeping the order which pages were found.  
Q: Some pages are marked as removed with a large X crossing the entire page and text 
that reads “This sheet deleted, see page 81A” or the like.  In this example, there was a page 
81, then another page 81 that was marked as removed and referred to page 81A.  
A: The deleted page does not need to be scanned (according to WVDOT), though it may be wise 
to scan it anyway. Make a note of it in the database either way.   
Q: Some sheets have no visible page number.     
A: Give them one for now, according to the sequence in which they were discovered. Keep them 
in the order they were discovered when creating the PDF document.  Make a note in the 
comments field of the database describing how they were numbered.  
Q: One Project Book can have sheets from multiple projects.  EXAMPLE: Project 32, 
starting on the second page it switches to a different project in a different county for 37 
pages before switching back to the original project listed on the cover sheet, beginning 
with page #2.  Another EXAMPLE: Project 17 has two pages appended to the end from 
unrelated projects.  Another EXAMPLE: Project 33, page 52 (there are two of them) is a 
seemingly random page from some unrelated project.  How should we handle examples 
like these?  Separate them?  Keep them in the same folder and number them as they 
appear?   
A: Those pages were usually put in there by WV DOT staff for a reason, so be sure they are 
arranged in the PDF as they were discovered.  As for naming the TIFFs, they are to be auto 
named based on the order they are in and remain inside the project folder in which they were 
found. Write a descriptive note in the comments field of the database.   
Q: Pages repeat, but with some revisions.  
A: The original un-revised page does not need to be scanned (according to WVDOT), and the 
revised page should get the original page number.  Scan the un-revised page anyway and note it 
in the comments field of the database.   
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APPENDIX B:  Image Processing Keyboard Shortcuts 
 
The following shortcuts can be used in Adobe Photoshop for Image Processing: 
  

Shortcut Action 
Ctrl + C Copy 
Ctrl + V Paste 
Ctrl + X Cut 
Ctrl + S Save 

Ctrl + Zero Zooms to Page Extent 
Z Switches to Zoom Mode 
C Switches to Crop Mode 

Ctrl + Tab Go to Next Image 
Ctrl + Alt + Shift + L Auto Contrast 

Ctrl + Alt + Z Undo Droplet Action 
HOLD Ctrl (While in Crop Mode) Use Straighten Tool 

Ctrl + Z Undo 
Ctrl + Plus Zoom in 

Ctrl + Minus Zoom out 
Ctrl + L Opens Levels Menu 

 
Additional shortcuts may be created using the Keyboard Shortcuts menu in Photoshop 
(Edit<Keyboard Shortcuts… or Alt + Shift + Ctrl + K)  
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APPENDIX C:  Procedure Hardware, Software, and Documents 
 

Procedural tasks associated with hardware, software, management documents. 

PROCESSING 
TASK HARDWARE SOFTWARE MANAGEMENT 

DOCUMENTS 
Book Preparation & 
File Naming 

Scanning 
Computers 

File Explorer 
Access  

dbo_scanning 

Scan Document Scanning 
Computers 

Softworks Pro 
Access 
Google Sheets 

dbo_scanningActivity  
DOT Performance Tracking 
  

Image Processing Local Workstation Adobe Photoshop 
Access 
Google Sheets 

dbo_scanningActivity  
DOT Performance Tracking 
 

Build PDF Local Workstation Adobe Acrobat DC 
Access 
Google Sheets 

dbo_scanningActivity  
DOT Performance Tracking 
 

Georeference Local Workstation 
Gistc-filesrv1 

ArcGIS 
Google Maps 
Access 
Google Sheets 

dbo_scanningActivity  
DOT Performance Tracking 
 

QA/QC Local Workstation 
Gistc-filesrv1 
 

ArcGIS 
FileRename.pyt 
Access 
Google Sheets 

dbo_scanningActivity  
DOT Performance Tracking 
dbo_scanning 
dbo_vw_ProjectKeyLookup 

Publishing & Web 
QC 

 

Local Workstation 
External Drive 
External Server 
Gistc-filesrv1 

PublishGeoTIFF.pyt 
BuildFootprints.pyt 
UpdateFootprints.pyt 
Access 
Google Sheets 

dbo_scanningActivity 
dbo_scanning 
DOT Web QC Status 
dbo_vw_ProjectKeyLookup 
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APPENDIX D:  Transmittal Sheet 
 

Project Key Project Title: 

 

 

 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17  18 19 20 21 22 23 

 
            

 
   

 
     

 

 Type 

 C
ounty ID

 

 Sign System
 

Route Number Sub 
Route  Begin Milepost 

 

Fiscal Year 

 
Scan Order Number 
 
S- Scanned at WVGIS TC 
D- Digitally Received by District 

(To be completed by scan tech.) 

1 4 5 6 7 8 

_ _ _ _ _ _ 

D
istrict # 

Special 

ID 

Status 
ID 

Supplemental 
Code 

9 

Bar # 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 

Bridge #  
 

_ 
 

_ 
 

_ 
 

_ 
 

_ 
 
. 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
. 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
. 

 
_ 

Notes: ProjectWise:     Y   /   N 

Supplemental 
 


	PROJECT OVERVIEW
	SEVEN MAJOR PROCEDURAL TASKS:
	VOCABULARY PRIMER
	FILE PATHS AND PINNING TO YOUR FILE VIEWER’S QUICK ACCESS

	(1)  PROJECT BOOK PREPARATION
	ACQUISITION AND SCANNING
	PROJECT BOOK INTAKE

	NAMING PROJECT BOOKS
	SCANNING FILE NAME CONVENTION
	ENTERING PROJECT BOOKS
	CODES / DATA DOMAIN VALUES
	HIGHWAY PLAN TYPES
	COUNTY CODES
	SIGN SYSTEM CODES
	SPECIAL CODES
	STATUS CODES
	SUPPLEMENTAL CODES



	(2)  SHEET SCANNING
	SCANNING PROCEDURES FOR 8.5x11 REPORTS
	SCANNER CLEANING AND MAINTENANCE
	SCANNING QUALITY ISSUES
	SCANNER CLEANING
	SCANNER CALIBRATION


	(3)  IMAGE PROCESSING
	ACTION CREATION PROCEDURES
	IMAGE PROCESSING PROCEDURES
	IMAGE SETTINGS AND ENHANCEMENTS
	AUTOMATED ACTIONS

	(4)  PDF BOOK
	PDF RESOURCE NOTES

	(5)  GEOREFERENCING HIGHWAY INDEX MAP
	ARCGIS PRO SETUP
	GEOREFERENCE PROCEDURES

	(6)  QUALITY CONTROL & FILE RENAMING
	QUALITY CONTROL PROCEDURES
	FILE RENAMING TO PROJECT KEY
	SET UP PROCEDURES
	RENAMING PROCEDURES
	POSSIBLE ISSUES WITH RENAMING:


	(7)  PUBLISHING (includes WEB QC & BACKUPS)
	DOT GEODATABASE OVERVIEW
	PUBLISHING GEOTIFFS
	ADD RASTERS
	BUILD FOOTPRINTS
	UPDATE FOOTPRINTS
	PUBLICATION STATUS
	FINAL WEBSITE QC
	WEBSITE TROUBLESHOOTING

	BACKUP PROCEDURES
	EXTERNAL DRIVE

	DIGITAL PLAN PROCEDURES

	APPENDIX A:  Page Number FAQ
	APPENDIX B:  Image Processing Keyboard Shortcuts
	APPENDIX C:  Procedure Hardware, Software, and Documents
	APPENDIX D:  Transmittal Sheet

